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Preface

Audience for This Guide

Welcome to Release 11 of the Oracle Interaction Center Intelligence Implementation
Guide.

This guide assumes you have a working knowledge of the following;:
»  The principles and customary practices of your business area.
s Oracle Interaction Center Intelligence

If you have never used Oracle Interaction Center Intelligence, Oracle suggests
you attend one or more of the Interaction Center training classes available
through Oracle University.

= The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This document contains the information you need to understand and use Oracle
Interaction Center Intelligence.

Chapter 1, "Introduction”, describes the components of the Interaction Center
product family and the key features of Oracle Interaction Center Intelligence. This
chapter also lists any new or obsolete features in this release.



Chapter 2, "Before You Begin", describes the technology stack for Oracle Interaction
Center Intelligence and the Oracle Interaction Center Intelligence architecture. This
chapter also describes applications that are required for Oracle Interaction Center
Intelligence to function or that provide additional functionality.

Chapter 3, "Implementation Tasks", provides task-based procedures for
implementing Oracle Interaction Center Intelligence.

Chapter 4, "Diagnostics and Troubleshooting", describes how to troubleshoot the
implementation of Oracle Interaction Center Intelligence.

Appendix A, "Oracle Interaction Center Intelligence Profile Options", lists profile
options for Oracle Interaction Center Intelligence.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Interaction Center Intelligence.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.



Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Interaction Center Intelligence shares business and setup information with
other Oracle Applications products. Therefore, you may want to refer to other
product documentation when you set up and use Oracle Interaction Center
Intelligence.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Interaction
Center Intelligence (and any other Oracle Applications products). This guide also
includes information on setting user profiles, as well as running and reviewing
reports and concurrent processes.

You can access this user’s guide online by choosing "Getting Started with Oracle
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Universal Work Queue Concepts and Procedures
Use this guide to administer and use Oracle Universal Work Queue.

Oracle Applications Interaction Center Implementation Guide
Use this guide to implement Interaction Center Server Manager.

Oracle Advanced Inbound Implementation Guide
Use this guide to implement inbound media for an interaction center.

xi



Xii

Oracle Advanced Outbound Implementation Guide
Use this guide to implement outbound media for an interaction center.

Oracle Scripting Implementation Guide
Use this guide to implement Oracle Scripting.

Oracle eMail Center Implementation Guide
Use this guide to implement Oracle eMail Center.

Oracle Interaction Center Intelligence Implementation Guide
Use this guide to implement Oracle Interaction Center Intelligence.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps

This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.



Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11.
You cannot upgrade to Release 117 directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.
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Other Implementation Documentation

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on Metalink

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Interaction
Center Intelligence and reach full productivity quickly. You have a choice of
educational environments. You can attend courses offered by Oracle University at
any one of our many Education Centers, you can arrange for our trainers to teach at
your facility, or you can use Oracle Learning Network (OLN), Oracle University's
online education utility. In addition, Oracle training professionals can tailor
standard courses or develop custom courses to meet your needs. For example, you
may want to use your organization’s structure, terminology, and data as examples
in a customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Interaction Center
Intelligence working for you. This team includes your Technical Representative,
Account Manager, and Oracle’s large staff of consultants and support specialists
with expertise in your business area, managing an Oracle8i server, and your
hardware and software environment.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain



information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160

XV



software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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1

Introduction

This chapter provides information on the following topics:

s Section 1.1, Oracle Interaction Center Overview

»  Section 1.2, Oracle Interaction Center Intelligence Overview
s Section 1.3, New in this Release

»  Section 1.4, Architecture and Technology

= Section 1.5, Security

= Section 1.6, Responsibilities

1.1 Oracle Interaction Center Overview

Every customer interaction — a telephone call, an e-mail message, or a Web chat
conversation — presents an opportunity to win new business or improve customer
satisfaction. The Oracle Interaction Center supports the management and
processing of customer relationship activity across all channels of customer contact.

The Oracle Interaction Center integrates with several customer relationship
business applications in the Oracle eBusiness Suite. The Oracle Interaction Center
consists of several modules. The modules relating to inbound telephony and
outbound telephony are bundled separately.

The Oracle Interaction Center allows access to centralized customer information
and business application functionality. Oracle Interaction Center integrates with
front office applications (known as Customer Relationship Management or CRM),
and back office applications (Enterprise Relationship Planning or ERP), thereby
enabling a workflow powered, end-to-end strategic e-business solution.

The Oracle Interaction Center products include:
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s Oracle Advanced Inbound

s Oracle Advanced Outbound

»  Oracle eMail Center

s Oracle Scripting

s Oracle Universal Work Queue

s Oracle Interaction Center Intelligence

See Also
m  Section 1.3, New in this Release

1.1.1 Oracle Advanced Inbound

Oracle Advanced Inbound (AlI) is required to telephony enable business
applications in the Oracle eBusiness Suite. "Telephony-enabled" means that the
product has the capability of communicating with a telephone system for inbound
calls, outbound calls, or both via the CTI middleware that handles the messaging
between a telephone switch and the user's application. Oracle Advanced Outbound
provides the corresponding outbound telephony capability.

The Oracle Advanced Inbound bundle consists of the following products: Call
Center Technology, Oracle Universal Work Queue, Oracle Telephony Manager, and
Oracle Interaction Blending.

See Also
s Oracle Advanced Outbound

s Oracle eMail Center
s Oracle Scripting
s Oracle Universal Work Queue

»  Oracle Interaction Center Intelligence

1.1.2 Oracle Advanced Outbound

Oracle Advanced Outbound (AO) is another key part of the Oracle eBusiness Suite
of applications. It is the module of Oracle Interaction Center that addresses
outbound telephony. AO consists of two main components:

= A tactical list manager, which determines who to call and when to call them

1-2 Oracle Interaction Center Intelligence Implementation Guide
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= Anoutbound dialing engine, which dials numbers and transfers live contacts to
call center agents

Advanced Outbound integrates with and relies on Oracle Marketing Online (OMO)
to create campaigns and lists to execute. AO serves as the execution arm for these
marketing lists to maximize both outbound list penetration and agent productivity.
AO also integrates with desktop applications like Oracle TeleSales and Oracle
Collections to handle the actual customer interactions. Oracle Advanced Outbound
can be used any time agents need to contact parties via the telephone.

AO also integrates with Oracle Interaction History to provide feedback that
marketers can use to analyze and measure the success of the marketing campaign,
thereby providing a closed-loop marketing process.

Oracle Advanced Outbound does not include any other telephony management
modules, and thus requires the use of Oracle Advanced Inbound.

See Also
s Oracle Advanced Inbound

s Oracle eMail Center
s Oracle Scripting
s Oracle Universal Work Queue

»  Oracle Interaction Center Intelligence

1.1.3 Oracle eMail Center

Oracle eMail Center (eMC) is designed to satisfy requirements for inbound
customer support, e-mail interaction management, and outbound sales and
marketing e-mail message processing.

Oracle eMail Center helps your business respond to e-mail queries with clear and
comprehensive replies in a much more efficient manner. eMC automatically
generates suggested responses and scores them according to how closely they
match the requirements.

See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
s Oracle Scripting
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s Oracle Universal Work Queue

s Oracle Interaction Center Intelligence

1.1.4 Oracle Scripting

Oracle Scripting is a set of tools to create and display information sequentially to
end users. Oracle Scripting is composed of three components: the Script Author, the
Scripting Engine, and the Survey Component.

Oracle Scripting end users include interaction center agents (for the Scripting
Engine), and customers or prospects using a Web browser (using the Survey
component). Other users include individuals who build the scripts (Script Author
users) and administrators of scripting or survey campaigns, who must access the
Survey Admin console.

Using Oracle Scripting, an enterprise gains the ability to develop and deploy
scripted presentations for customer interactions with agents, as well as build,
deploy, and execute information-gathering survey campaigns for data which can be
mined and used to tailor sales and service campaigns or improve customer
satisfaction.

See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
s Oracle eMail Center
s Oracle Universal Work Queue

»  Oracle Interaction Center Intelligence

1.1.5 Oracle Universal Work Queue

Oracle Universal Work Queue is an agent portal that presents and delivers work
items generated through customer contact channels or CRM business applications.
Agents can select work directly from the Oracle Universal Work Queue desktop
user interface.

Work which originates from a customer contact channel, such as a telephone call or
an e-mail, is called a media work item. Work which originates from a CRM business
application, such as a task or lead, is called an application work item. You can set up
Oracle Universal Work Queue to handle application work items only, or both
application and media work items.
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See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
s Oracle eMail Center
s Oracle Scripting

= Oracle Interaction Center Intelligence

1.2 Oracle Interaction Center Intelligence Overview

The competitive environment in which we all thrive, challenges interaction centers
to provide ever greater customer satisfaction, more consistent customer interactions,
increase efficiencies and reduce costs towards increasing revenues and bottom line
profits. Interaction Center Intelligence is a web-based operational
performance-management application for interaction center supervisors, managers
and agents.

As the customer touchpoints become more sophisticated, the need to understand
and manage these complex touchpoints become imperative. Supervisors and
managers need to quickly and accurately gather interaction and business
application data (queue depth, length and peaks; agent productivity - converted
opportunities, closed service requests, agent utilization, service levels) to make
tactical and strategic decisions. Agents can monitor and motivate themselves with
access to their own efficiency and effectiveness results.

Interaction activity is monitored down to half hour time segments and is available
for:

= Advanced Inbound

= Advanced Outbound

= eMail Center

s Universal Work Queue

Interaction Center Intelligence provides real time monitoring of advanced inbound
agents and queues. Agent group snapshots with drill-downs to agents expose
activity status, competencies and daily time reporting.

Queue snapshots monitor calls waiting, longest call waiting and daily cumulative
metrics with drill-downs to agents working on a particular call classification.
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Self service reporting is supported through an agent group based security model.
An enhanced user experience with little or no training is derived through an
intuitive HTML interface with bins, drill-downs and a variety of 3-D

graphics. Application dependencies for business data from Oracle TeleService and
TeleSales are managed via simple setup. Interaction Center Intelligence is the only
reporting solution to bridge CTI (computer telephony integration), transactional
businessapplicationsand agentinformation, minimizingimplementationtimesand
total cost of ownership.

See Also

Section 1.1, Oracle Interaction Center Overview

Section 1.3, New in this Release

1.2.1 Oracle Interaction Center Intelligence Features

Oracle Interaction Center Intelligence:

Monitoring of interaction activity down to half hour time segments for the
following Oracle Applications:

= Advanced Inbound

= Advanced Outbound

= eMail Center

s Universal Work Queue

Real time monitoring of advanced inbound agents and queues.

Agent group snapshots with agent drill-down for viewing activity status,
competency, and daily time reporting.

Queue snapshots which provide a view of calls waiting, longest call waiting
and daily cumulative metrics with drill-downs to agents working on a
particular call classification.

Self service reporting is supported through an agent group based security
model.

Intuitive HTML interface with bins, drill-downs and a variety of 3-D graphics.

Bridges CTI (computer telephony integration), transactional business
applications and agent information.

There are 7 bins in which a user can subscribe (2 real time and 5 historical).
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s There are 22 reports with information down to half-hour segments (4 real time
reports and 18 historical reports).

1.2.1.1 Home Page

Every user has the option of customizing their home pages by clicking on the
Personalize link on the top right corner of the page. This will allow them to choose
which bins, reports or graphs they want to see on their page. The administrator
decides which components can be accessed by which users/responsibilities.

1.2.1.2 Bins

Bins provide crucial performance statistics for calls, agents and queues are
presented up front in the form of bins. These provide you with condensed
up-to-date information even before running a single report.

Bins offer you a condensed snapshot of the key metrics in your interaction center to
give you a quick indication of the performance of your center. These bins also
provide drill-downs to the more detailed reports for further investigation.

The bins are:

= Agent Email

= Agent Status

= Calls Handled
»  Classification

= Email Accounts
s Queue Status

s UWQ Activity

1.2.1.3 Real-Time Reports

The real-time reports can provide up-to-the-minute information on key
performance metrics. Real-time reports help you uncover problems as soon as they
occur to help you take immediate action. These reports serve as very useful tools to
plan the day's activities.

They are:
= Agent Status Report
= Agent Detail Report
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= Queue Status Report
= Queue Detail Report

1.2.1.4 Historical Reports

Historical reports can report on customer interactions for half-hour time segments.
Data can be collected daily or at any other pre-determined interval. These reports
have very detailed information of various important measures, grouped, filtered
and sorted by numerous parameters. In conjunction with bins, these reports provide
actionable business intelligence to the interaction center manager.

They are:

= Agent by Classification Report

= Agent Group Report

= Agent Productivity by Campaign Report
= Campaign Dialing by Agent Report

= Campaign Outcomes by Agent Report

s Campaign Outcomes Report

= Campaign Performance by Agent Report
= Campaign Performance Report

n  Classification Report

= DNIS Report

s Email Account Report

= Email Account Agent Report

s Email Agent Group Report

s Key Performance Comparison by Period Report
= Session Logins Report

= Session Duration Report

»  Transactional KPIs - Agent Report

» Transactional KPIs - Classification Report
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1.3 New in this Release

= Two new bins and three reports that support eMail Center integration.
- Agent Email Bin
—  Email Accounts Bin
—  Email Account Agent Report
—  Email Account Report
— Email Agent Group Report

= Six new reports that support Advanced Outbound integration.
- Agent Productivity by Campaign Report
- Campaign Dialing by Agent Report
- Campaign Performance by Agent Report
- Campaign Performance Report
— Campaign Outcomes by Agent Report
— Campaign Outcomes Report

= Ability to export data to Excel

= Diagnostics tool

See Also
= Section 1.3.1, Agent Email Bin

s Section 1.3.2, Email Accounts Bin

= Section 1.3.3, Agent Productivity by Campaign Report
= Section 1.3.4, Campaign Dialing by Agent Report

= Section 1.3.5, Campaign Performance by Agent Report
= Section 1.3.6, Campaign Performance Report

= Section 1.3.7, Campaign Outcomes by Agent Report

= Section 1.3.8, Campaign Outcomes Report

= Section 1.3.9, Email Account Agent Report

= Section 1.3.10, Email Account Report
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s Section 1.3.11, Email Agent Group Report
= Section 1.3.12, Exporting Data to Excel

1.3.1 Agent Email Bin

The Agent Email bin is a historical bin that displays the following information by
agent group:

s Number of e-mails fetched

= Number of fetched e-mails that have not been processed

s The age of the oldest e-mail that has been fetched but not processed

You can access an Email Agent Group report by clicking the agent group hyperlink.

1.3.2 Email Accounts Bin

The Email Accounts bin is a historical bin that displays the following information
by email account:

s The number of e-mails
»  The age of the oldest e-mail
s The number of fetched e-mails that have not been processed

You can access an Email Account report by clicking the account hyperlink.

1.3.3 Agent Productivity by Campaign Report

The Agent Productivity by Campaign report displays information about an agent’s
productivity by campaign. You can filter the report by agent, campaign, campaign
schedule, agent group, and timeperiod.

1.3.4 Campaign Dialing by Agent Report

The Campaign Dialing by Agent report displays information about dialing statistics
for a campaign by agent. You can filter the report by agent, campaign, campaign
schedule, agent group, and timeperiod.
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1.3.5 Campaign Performance by Agent Report

The Campaign Performance by Agent report displays information about outbound
call and transaction activity for an agent. You can filter the report by interaction
center site, campaign schedule, agent group, and timeperiod.

1.3.6 Campaign Performance Report

The Campaign Performance report displays information about outbound call
details, connects, contacts, and positive responses by campaign. You can filter the
report by interaction center site, campaign schedule, agent group, and timeperiod.

1.3.7 Campaign Outcomes by Agent Report

The Campaign Outcomes by Agent report displays information about outcomes,
results, and reasons for campaigns by agent. You can filter the report by agent,
campaign, campaign schedule, target group, and timeperiod.

1.3.8 Campaign Outcomes Report

The Campaign Outcomes report displays information about outcomes, results, and
reasons for campaigns. You can filter the report by agent, campaign, campaign
schedule, target group, and timeperiod.

1.3.9 Email Account Agent Report

The Email Account report displays information about email activity for an agent
group. You can filter the report by email account, email classification, and
timeperiod.

1.3.10 Email Account Report

The Email Account report displays information about email activity for an email
account. You can filter the report by email account, email classification, and
timeperiod.

1.3.11 Email Agent Group Report

The Email Agent Group report displays information about email activity for an
email account. You can filter the report by agent group, email account, and
timeperiod.
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1.3.12 Exporting Data to Excel

The ability to export report data to Excel has been added as a feature to Oracle
Interaction Center Intelligence. Report data is downloaded as a text file in a .csv file
format.

1.4 Architecture and Technology

Interaction Center Intelligence is a web based product, which gives a easy-to-use
intelligence reporting mechanism for business users and is based on a three-tier
architecture.

»  The front end or the client who is using the system through a simple web
browser (no other software is required on the user's machine).

s The middle tier, which contains the web server (Apache server) and application
server (Forms), which come as part of the Oracle Applications installation.

s The database tier, which is an Oracle 8i database.

Interaction Center Intelligence is built using the Declarative Components
Framework which is provided as a part of the Oracle CRM Foundation (JTF)
module. Declarative Components are personalizable software objects that are
dynamically generated from a metadata repository. ICI contains the following types

of objects:
= Bins
= Report

= Graph Report

Each component derives its data content format from three distinct layers:
s Data: the actual data content which resides in the target database tables
= Metadata: stored in Oracle's AK tables

= Renderer: a rendering mechanism provided by JTF

There are two kinds of information: real time and historical. For real time
information, the programs read directly from the OLTP (transactional) base tables to
generate the data content. The historical reports on the other hand read from a set of
intermediate summary tables which are designed are optimum query performance.
Population programs run periodically to populate the intermediate tables and the
reports are run off these tables.
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1.5 Security

Security is controlled by the standard Oracle Applications security framework.
Every user of the system must be granted some responsibilities. When the user logs
in to ICI, the components that are available would depend on the responsibility that
the user is associated with. Responsibilities are assigned by the System
Administrator using Oracle Applications. Once the user is granted certain
responsibilities, the user has the flexibility within the ICI application, to change to a
different responsibility.

Each component (bin/report/graph) can be assigned to a responsibility. The
pre-seeded ICI responsibilities (Interaction Center Intelligence User HTML and
Interaction Center Intelligence Administrator HTML) have access to all the ICI
components, by default. If a user logs on with a responsibility which does not have
the appropriate access rights, the user will be unable to run a bin or report to which
the administrator has not specifically granted access. This process of configuring
component security is done by logging in to the Oracle Applications JTF page as an
Administrator. Since this is a JTF feature, please refer to the Oracle CRM
Foundation guide for more details on this feature.

1.6 Responsibilities
ICI comes pre-seeded with the following responsibilities:
s Interaction Center Intelligence User HTML
This responsibility allows the user to run and view bins, reports, and graphs.
= Interaction Center Intelligence Administrator HTML

This responsibility allows the user to run and view the components, and set up
application wide profiles (e.g., goals, application dependencies).

= Interaction Center Intelligence User Apps
This responsibility allows users to set up their profile values.
= Interaction Center Intelligence Administrator Apps

This responsibility allows the user to run concurrent programs and set up
profiles which are needed for ICL

The administrator may choose to seed other custom responsibilities as well
depending on the requirements of the organization. ICI supports security at a
component level. If a component is accessible only by a certain responsibility, users
who do not have this responsibility will be unable to view this component. This

Introduction 1-13



Responsibilities

allows administrators to control component security at a very granular level.
Depending on the needs of the organization, the administrator might decide that
new responsibilities are needed, in addition to the four pre-seeded responsibilities.
If needed, these new responsibilities can be created through Oracle Applications as
a System Administrator.

1-14 Oracle Interaction Center Intelligence Implementation Guide



2

Before You Begin

This chapter provides an overview of what you need to have installed,
implemented, and verified before implementing the Oracle Interaction Center
Intelligence.

Topics include:
s Section 2.1, "Related Documentation”

»  Section 2.2, "Dependencies"

2.1 Related Documentation

This section lists documentation and other information related to the
implementation of Oracle Interaction Center Intelligence (ICI). ICI shares business
and setup information with other Oracle Applications products.

Documentation
You will need the following guides to implement Oracle Interaction Center

Intelligence.

Oracle Interaction Center Implementation Guide
Use this guide to implement Interaction Center Server Manager.

Oracle Universal Work Queue Concepts and Procedures
Use this guide to administer and use Oracle Universal Work Queue.

Oracle Advanced Inbound Implementation Guide
Use this guide to implement inbound media for an interaction center.
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Oracle Advanced Outbound Implementation Guide
Use this guide to implement outbound media for an interaction center.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

2.2 Dependencies

Oracle Interaction Center Intelligence depends on other Oracle Applications
products and components. When Interaction Center Intelligence is first installed, it
will be set up with empty summary tables and materialized views. These need to be
refreshed from the base transaction tables which reside in the corresponding OLTP
schemas. For ICI to be fully functional the system administrator needs to ensure
that the dependencies are met and that the base OLTP tables contain data.

2.2.1 ICl Tables

The following table lists the tables that are created in the BIX schema for use by ICI
programs:
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Table

Description

BIX_DM_UWQ_AGENT_SUM

This table stores Universal Work Queue
information summarized by day by agent. The
format of this table closely reflects the format
that is used in the reports. This facilitates better
query performance as the bins/reports perform
a direct select from the summary table at
run-time, without having to hit the transactional
tables. The table stores total durations. Average
durations are calculated at run-time while
rendering the bin/report.

BIX_DM_UWQ_GROUP_SUM

This table stores Universal Work Queue
information summarized by day by group. The
format of this table closely reflects the format
that is used in the reports. This facilitates better
query performance as the bins/reports perform
a direct select from the summary table at
run-time, without having to hit the transactional
tables. The table stores total durations. Average
durations are calculated at run-time while
rendering the bin/report.

BIX_DM_AGENT_SUM

This table stores Call related information,
summarized by agent, per half hour.

BIX_DM_GROUP_SUM

This table stores Call related information,
summarized by agent, per half hour.

BX_DM_CALL_SUM

This table stores Call related information
summarized per half hour.

BIX_DM_AGENT_OUTCOME_SUM

This table stores information relating to the
outcomes of outbound calls, summarized by
agent, per half hour.

BIX_DM_GROUP_OUTCOME_SUM

This table stores information relating to the
outcomes of outbound calls, summarized by
agent group, per half hour.

BIX_DM_AGENT_SESSBYCAMP_
SUM

This table stores information relating to the
agents login time and work time, summarized
by campaign schedule, per agent, per half hour.

BIX_DM_AGENT_SESSBYCAMP_
SUM

This table stores information relating to the
agents login time and work time, summarized
by campaign schedule, per agent, per half hour.
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Table

Description

BIX_DM_GROUP_SESSBYCAMP_SUM

This table stores information relating to the
agent group’s login time and work time,
summarized by campaign schedule, per agent
group, per half hour.

BIX_DM_EMAIL_AGENT_SUM

This table contains eMail Center agent related
measures summarized by the emails account
(Account to which emails came in),
Classification of Email (E.g.: GOLD, SILVER),
Resource and Time.

BIX_DM_EMAIL_GROUP_SUM

This table contains eMail Center agent related
measures summarized by the Email account
(Account to which emails came in),
Classification of Email (E.g.: GOLD, SILVER),
Resource Group and Time.

BIX_DM_EMAIL_SUM

This table contains eMail Center measures
summarized the emails account (Account to
which emails came in), Classification of Email
(E.g.: GOLD, SILVER) and Time.

BIX_DM_CONNECT_LOOKUPS

This is a lookup table which maps outcomes to
connects. As an example, an outcome of
“Answering Machine’ could be considered as a
“Connect” and an outcome of “Busy” could be
considered as a “Non-connect”. This mapping is
done at the customer site using the setup screen
provided for this purpose in ICI. This is one of
the required post-install steps for ICL.

BIX_DM_RESPONSE_LOOKUPS

This is a lookup table which maps results to
responses. The mapping is done at the customer
site using the setup screen provided for this
purpose in ICI. This is one of the required
post-install steps for ICI.

BIX_DM_INTERFACE

This is table is used by the summary programs
as an intermediate table which stores calculated
values of some measures. The other summary
tables are populated using this interface table.

BIX_DM_COLLECT_LOG

This table records information relating to the
execution of the concurrent programs which
populate the four summary tables mentioned
above. Administrators can check this table after
every run of the concurrent program.
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Table

Description

BIX_DM_GOALS

This table stores organization related
performance goals for Telephony for each
classification. These goals/measures are used
by some of the reports to perform intelligent
analysis on performance of call center, agents
etc. This table contains one pre seeded row with
a classification_id of -999 for “ALL”
classifications. If the goal is not defined for any
classification, the “ALL” classification goal is
applied for calculating summary columns
related to goal

BIX_DM_GOALS_EMC

This table contains goals defined for Email
Center for each classification. This table
contains one pre seeded row with a
classification_id of -999 for “ALL”
classifications. If the goal is not defined for any
classification, the “ALL” classification goal is
applied for calculating summary columns
related to goals.

BIX_DM_APPS_DEPENDENCY

This table is populated from the Application
Setup Screen, when the user clicks on “Setup
Application Dependencies”. The data in this
table will be used by the summary table
population programs to selectively populate
certain columns based on whether or not the
corresponding OLTP module exists or not.

BIX_DM_EXCEL

This table is used by the reports while exporting
data out to a Excel spreadsheet. The table is
used as an intermediate store before moving the
data to the Excel file.

The database administrator is responsible for sizing these tables according to the
needs of the organization. The administrator is also responsible for deciding on the
organization's purging mechanism and timeframe. Right now, ICI does not provide
a default purge mechanism, as this can vary from one organization to another. Refer
to the Interaction Center Intelligence Technical reference Manual for further details

on these tables.

2.2.2 ICI Summary Tables and Views

The following table provides a list of ICI summary tables or materialized views and
the base tables for which they depend on data. Please refer to the Oracle
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Applications CRM Technical Reference Manual for Release 11.5.8 for detailed

information on each of the base tables and their functionality.

Summary Table

Tables/Views Used for Data Extraction

BIX_DM_UWQ_AGENT_SUM

IEU_SH_SESSIONS

BIX_DM_UWQ_GROUP_SUM

BIX_DM_UWQ_AGENT_SUM

JTE_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_INTERFACE

JTF_IH_INTERACTIONS

JTF_IH_MEDIA_ITEMS

JTF_IH_MEDIA_ITEM_LC_SEGS

JTF_IH_MEDIA_ITM_LC_SEG_TYS

JTE_RS_RESOURCE_EXTNS

JTF_RS_GROUP_MEMBERS

JTF_RS_GROUP_DENORM

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES

IEC_G_LIST_SUBSETS

AMS_ACT_LISTS

AMS_LIST_HEADERS_ALL

AMS_CAMPAIGN_SCHEDULES_VL

AS_SALES_LEADS

AS_LEADS_ALL

AS_STATUSES_VL

CS_INCIDENTS_ALL_B

CS_INCIDENTS_STATUSES_VL

BIX_DM_GOALS

BIX_DM_AGENT_SUM

BIX_DM_INTERFACE

BIX_DM_GROUP_SUM

BIX_DM_AGENT_SUM

JTF_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_CALL_SUM

BIX_DM_INTERFACE

BIX_DM_AGENT_OUTCOME_SUM

BIX_DM_INTERFACE

BIX_DM_CONNECT_LOOKUPS

BIX_DM_RESPONSE_LOOKUPS

BIX_DM_GROUP_OUTCOME_SUM

BIX_DM_AGENT_OUTCOME_SUM
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Summary Table

Tables/Views Used for Data Extraction

JTF_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_AGENT_SESSION_SUM

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES

BIX_DM_GROUP_SESSION_SUM

BIX_DM_AGENT_SESSION_SUM

JTE_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_AGENT_SESSBYCAMP_SUM

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES

IEU_UWQ_MEDIA_TYPES_TL

JTF_RS_RESOURCE_EXTNS

AMS_CAMPAIGN_SCHEDULES_B

BIX_DM_GROUP_SESSBYCAMP_SUM

BIX_DM_AGENT_SESSBYCAMP_SUM

JTF_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_EMAIL_AGENT_SUM

JTF_IH_MEDIA_ITEMS

JTF_IH_MEDIA_ITEM_LC_SEGS

JTF_IH_MEDIA_ITM_LC_SEG_TYS

BIX_DM_EMAIL_GROUP_SUM

BIX_DM_EMAIL_AGENT_SUM

JTE_RS_GROUP_MEMBERS

JTF_RS_GROUPS_DENORM

BIX_DM_EMAIL_SUM

JTE_IH_MEDIA_ITEMS

JTF_IH_MEDIA_ITEM_LC_SEGS

2.2.3 ICI Report Components

The following table provides a list of the ICI report components and the base tables
for which they depend on data. Note that some of the tables are ICI summary tables

and others are OLTP tables.
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Bin/Report Name

Tables/Views Used for Generation

Agent Status Bin

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES

JTF_IH_MEDIA_ITEM_LC_SEGS

JTE_IH_MEDIA_ITM_
LC_SEG_TYS

JTF_IH_INTERACTIONS

JTF_IH_MEDIA_ITEMS

Queue Status Bin

JTEF_IH_MEDIA_ITEM_
LC_SEGS

JTE_IH_MEDIA_ITM_LC_SEG_TYS

JTF_IH_MEDIA_ITEMS

UWQ Activity Bin
BIX_DM_UWQ _ BIX_DM_UWQ_GROUP_SUM
AGENT_SUM
Calls Handled Bin BIX_DM_AGENT_CALL_SUM
BIX_DM_GROUP_
CALL_SUM

Classification Bin

BIX_DM_AGENT_

CALL_SUM

Agent Email Bin
BIX_DM_EMAIL_ BIX_DM_EMAIL_GROUP_SUM
AGENT_SUM
JTF_RS_GROUP_ JTF_RS_RESOURCE_EXTNS
MEMBERS

JTE_RS_GROUPS_VL

JTF_RS_GROUPS_DENORM

Email Accounts Bin

BIX_DM_EMAIL_AGENT_SUM

IEM_EMAIL_
ACCOUNTS

Agent Detail Report

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES
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Bin/Report Name

Tables/Views Used for Generation

JTF_IH_MEDIA_ITEM_

JTF_IH_MEDIA_ITM_LC_SEG_TYS

LC_SEGS

JTF_RS_RESOURCE_ JTE_IH_INTERACTIONS
EXTNS_VL

JTF_RS_GROUP_ Agent Status Report
MEMBERS

IEU_SH_SESSIONS

IEU_SH_ACTIVITIES

JTF_RS_RESOURCE_

JTF_RS_GROUPS_VL

EXTNS_VL

JTF_RS_GROUP_ JTF_IH_MEDIA_ITEM_LC_SEGS
MEMBERS

JTE_IH_MEDIA_ITM_ JTF_IH_INTERACTIONS
LC_SEG_TYS

Queue Detail Report BIX_DM_AGENT_CALL_SUM

Queue Status Report

JTF_IH_MEDIA_ITEM_LC_SEGS

JTF_IH_MEDIA_ITM_

JTF_IH_MEDIA_ITEMS

LC_SEG_TYS

JTF_RS_GROUP_ JTF_IH_INTERACTIONS
MEMBERS

Agent Group Report BIX_DM_CALL_SUM

BIX_DM_AGENT_SUM

BIX_DM_GROUP_SUM

BIX_DM_AGENT_
SESSION_SUM

BIX_DM_GROUP_SESSION_SUM

Agent by Classification

Report

BIX_DM_CALL_SUM

BIX_DM_AGENT_SUM

BIX_DM_GROUP_SUM

BIX_DM_AGENT_
SESSION_SUM

BIX_DM_GROUP_SESSION_SUM
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Bin/Report Name Tables/Views Used for Generation
Transactional KPIs BIX_DM_CALL_SUM

-Agent Report

BIX_DM_GROUP_SUM BIX_DM_AGENT_SUM
BIX_DM_AGENT_ BIX_DM_GROUP_SESSION_SUM

SESSION_SUM

Session Logins Report BIX_DM_UWQ_AGENT_SUM

BIX_DM_UWQ_

GROUP_SUM

Session Durations Report
BIX_DM_UWQ_ BIX_DM_UWQ_GROUP_SUM
AGENT_SUM

Classification Report BIX_DM_CALL_SUM

Key Performance BIX_DM_CALL_SUM
Comparison by Period

Report

Transactional KPIs - BIX_DM_CALL_SUM
Classification Report

BIX_DM_UWQ_ BIX_DM_UWQ_GROUP_SUM
AGENT_SUM

DNIS Report BIX_DM_CALL_SUM

Campaign Performance  BIX_DM_AGENT_SESSBYCAMP_SUM
Report

BIX_DM_CALL_SUM AMS_CAMPAIGNS_VL

AMS_CAMPAIGN_
SCHEDULES_VL
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Bin/Report Name

Tables/Views Used for Generation

Campaign Performance by Agent Report

BIX_DM_AGENT_SUM

BIX_DM_GROUP_SUM

BIX_DM_AGENT_
SESSBYCAMP_SUM

BIX_DM_GROUP_SESSBYCAMP_SUM

BIX_DM_CALL_SUM

AMS_CAMPAIGNS_VL

AMS_CAMPAIGN_
SCHEDULES_VL

Campaign Dialing by Agent Report

BIX_DM_AGENT_SUM

BIX_DM_GROUP_SUM

BIX_DM_AGENT_
SESSBYCAMP_SUM

BIX_DM_GROUP_SESSBYCAMP_SUM

BIX_DM_CALL_SUM

AMS_CAMPAIGNS_VL

AMS_CAMPAIGN_
SCHEDULES_VL

Campaign Outcomes Report

BIX_DM_AGENT_
OUTCOME_SUM

JTF_IH_OUTCOMES_VL

JTF_IH_RESULTS_VL

AMS_CAMPAIGNS_VL

AMS_CAMPAIGN_
SCHEDULES_VL

Campaign Outcomes by Agent Report

BIX_DM_AGENT_
OUTCOME_SUM

BIX_DM_GROUP_OUTCOME_SUM

JTF_IH_OUTCOMES_VL

JTF_IH_RESULTS_VL

AMS_CAMPAIGNS_VL

AMS_CAMPAIGN_SCHEDULES_VL

Agent Productivity by
Campaign Report

BIX_DM_AGENT_SUM

BIX_DM_GROUP_SUM

BIX_DM_AGENT_SESSBYCAMP_SUM

BIX_DM_GROUP_
SESSBYCAMP_SUM

BIX_DM_CALL_SUM
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Bin/Report Name Tables/Views Used for Generation

AMS_CAMPAIGNS_VL AMS_CAMPAIGN_SCHEDULES_VL

Email Account Report BIX_DM_EMAIL_SUM

IEM_EMAIL_ IEM_ROUTE_CLASSIFICATIONS
ACCOUNTS

Email Account Agent BIX_DM_EMAIL_AGENT_SUM
Report

IEM_EMAIL _ JTF_RS_RESOURCE_EXTNS_VL
ACCOUNTS

Email Account Agent BIX_DM_EMAIL_AGENT_SUM
Group Report

BIX_DM_EMAIL_ JTF_RS_GROUP_MEMBERS
GROUP_SUM

JTE_RS_RESOURCE_ JTF_RS_GROUPS_VL
EXTNS_VL

JTF_RS_GROUPS_
DENORM
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Implementation Tasks

This chapter describes the setup and configuration tasks required to successfully
implement Oracle Interaction Center Intelligence.

Topics include:

= Section 3.1, Defining an Administrator for Oracle Interaction Center Intelligence
= Section 3.2, Creating an Interaction Center Agent

= Section 3.3, Creating an Employee

= Section 3.4, Creating an Employee in CRM Resource Manager

»  Section 3.5, Setting Up Employees as Users

= Section 3.6, Importing a Resource

»  Section 3.7, Administering Oracle Interaction Center Intelligence

3.1 Defining an Administrator for Oracle Interaction Center Intelligence

Use the following procedure to define an administrator for Oracle Interaction
Center Intelligence.

Login

Oracle Forms Applications

Responsibility

System Administrator
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Prerequisites
»  Review Oracle Applications Systems Administrator’s Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Security > User >
Define.

The User window appears.

Use the following guidelines to define Oracle Applications usernames:

= Use only one word.

= Use only alphanumeric characters (A’ through 'Z’, and "0” through ’9").

= Use only the set of characters that your operating system supports for
filenames.

2. In the User Name field, enter the name of the user.

The password is temporary. When the user signs on to Oracle Applications for
the first time, the message “Your password has expired” appears and the user is
prompted to set a new password.

Use the following guidelines to define Oracle Applications passwords:
»  Use at least five characters and no more than 100 characters.
= Use only alphanumeric characters ("A’ through 'Z’, and "0” through ’9").

3. In the Password field, enter the password for the user account and then press
Tab.

The cursor remains in the Password field.
4. Enter the password again to verify it.
5. In the Responsibilities tab, add the following responsibilities.
= Interaction Center Intelligence Administrator Apps
s Interaction Center Intelligence Administrator HTML
s Interaction Center Intelligence User HTML
s Interaction Center Intelligence User Apps

Once the user record has been saved, you cannot delete an assigned
responsibility. Oracle Applications maintains audit data for assigned
responsibilities.
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To deactivate an assigned responsibility, set the effective end date (in the
Effective Dates - To field) of the assigned responsibility to the current date. To
activate an assigned responsibility, clear or reset the effective end date.

6. From the File menu, choose Save.

You may close the Users window.

See Also
= Section 1.6, Responsibilities

m  Section 3.2, Creating an Interaction Center Agent

= Section 3.3, Creating an Employee

= Section 3.4, Creating an Employee in CRM Resource Manager
= Section 3.5, Setting Up Employees as Users

m  Section 3.6, Importing a Resource

= Section 3.7.1, Configuring Application Profile Options

3.2 Creating an Interaction Center Agent

Every application user must be an authorized user of Oracle Applications. An
application user is uniquely identified by a username and password. Once defined,
an application user can sign on to Oracle Applications and access data through
Oracle Applications user interfaces.

An application user is granted one or more responsibilities. A responsibility is a
level of authority in Oracle Applications that allows a user to access specific Oracle
Applications functions.

An application user enters a username to sign on to Oracle Applications. It is
helpful to define meaningful usernames, such as the first initial and last name of an
employee, or for a group account, the name of the group.

An application user enters a password along with his/her username to sign on to
Oracle Applications.

All Oracle Applications are installed with predefined responsibilities. Instances of
the major components that help define a responsibility (data groups, request
security groups, menus, and functions) are predefined for Oracle Applications. A
system administrator can assign users any of the standard responsibilities provided
with Oracle Applications or create new custom responsibilities. The responsibility
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key is a unique name for a responsibility. After the responsibility records are saved,
the responsibility key cannot be updated. However, the responsibility name can be
changed at any time. If a user has more than one responsibility, then the
responsibility name appears in the Responsibilities window after a user signs on to
the Oracle Application.

You will need to perform the following steps to create an interaction center agent
for Oracle Interaction Center Intelligence.

Note: An administrator must be defined for the interaction center.
Once defined, that user will have all of the responsibilities
necessary to create interaction center agents.

1. Create an employee.
Create an Oracle Applications user account.
Create a resource for the employee.

Configure system profile options.

a0 DN

Configure resource roles and assign responsibilities for the newly created
resource.

6. Create group member roles and usage for an agent.

This step applies to implementations that also include Oracle Telesales and is
performed in CRM Resource Manager.

7. Configure interaction center parameters for the agent.

This step applies to media work only and configuration must be performed for
interaction center server group and telephony parameters. These parameters are
defined using CRM Resource Manager.

See Also
= Section 3.1, Defining an Administrator for Oracle Interaction Center Intelligence

= Section 3.3, Creating an Employee

= Section 3.4, Creating an Employee in CRM Resource Manager
= Section 3.5, Setting Up Employees as Users

= Section 3.6, Importing a Resource

= Section 3.7.1, Configuring Application Profile Options
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»  Oracle Interaction Center Implementation Guide

3.3 Creating an Employee

The agent who will be using Oracle Interaction Center Intelligence must first be
defined as an employee before they can be set up as a user on the system. This step
is performed using Oracle Human Resource Management Systems (if installed)
otherwise, it is accomplished through CRM Resource Manager.

Note: If you have a full Oracle HRMS license, you will be able to
create employees using Oracle HRMS. If you have a shared Oracle
HRMS license or if Oracle HRMS is not installed, you will need to
use CRM Resource Manager. The navigation paths will vary
depending on whether you have a full license or a shared license. If
you have the full installation of Oracle Human Resources, which is
a module of Oracle HRMS, you will perform this step using HRMS
Manager responsibility. See Managing People Using Oracle HRMS
Release 111 for additional information.

Login

Oracle Forms Applications

Responsibility
HRMS Manager

Prerequisites
s Administrative user must be created.

Steps
1. In the Navigator window, on the Functions tab, choose People > Enter and
Maintain.

The Find Person window appears.
2. Click New.
The People window appears.

3. Enter the appropriate information for the employee.
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Note: The Last (Name), Gender, and Type fields are required.
Other fields may be required depending on how Oracle Human
Resource Management Systems is set up for your enterprise. Make
sure that you select "Employee" as the type in the Type field. If the
Employee (Number) field is unavailable for selection, then Oracle
HRMS is set to automatically generate the employee number when
the employee record is saved. If you leave the fields such as SSN
and DOB blank, when you save the record, a message indicating
the consequences of leaving the fields blank will display.

4. From the File menu, choose Save.

See Also
»  Section 3.2, Creating an Interaction Center Agent

= Section 3.4, Creating an Employee in CRM Resource Manager
= Section 3.5, Setting Up Employees as Users

= Section 3.6, Importing a Resource

= Section 3.7.1, Configuring Application Profile Options

= Managing People Using Oracle HRMS Release 111

3.4 Creating an Employee in CRM Resource Manager

Use this procedure to create an employee when you have a shared Oracle HRMS
License or if Oracle HRMS is not installed. This procedure populates the same
database tables as the Enter and Maintain procedure in Oracle Human Resource
Management Systems.

Note: If you have the full installation of Oracle HRMS license you
will not be able to create employees using CRM Resource Manager
and will receive an error message indicating that you must use

Oracle HRMS.

Login

Oracle Forms Applications
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Responsibility
CRM Resource Manager

Prerequisites

None

Steps
1.

In the Navigator window, on the Functions tab, choose Maintain Employee >
Employee.

The Find Person window appears.
Click New.
The People window appears.

Enter the appropriate information for the employee.

Note: The Last (Name), Gender, and Category fields are required.
Other fields may be required depending on how Oracle Human
Resource Management Systems is set up for your enterprise. Make
sure that you select "Employee" as the type from the list of values in
the Type field. If the Employee (Number) field is unavailable for
selection, then Oracle HRMS is set to automatically generate the
employee number when the employee record is saved. If fields
such as SSN and DOB are left blank, when you attempt to save the
record, a message will display describing the consequences of their
incompleteness.

4. From the File menu, choose Save.

See Also

Section 3.1, Defining an Administrator for Oracle Interaction Center Intelligence
Section 3.2, Creating an Interaction Center Agent

Section 3.3, Creating an Employee

Section 3.5, Setting Up Employees as Users
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3.5 Setting Up Employees as Users

Use this procedure to create an Oracle Applications user for the employee. As
discussed in the Creating an Employee section of this document, an employee must
be defined before a user account can be established. When a user account is created,
in addition to the username and password being set, responsibilities have to be
assigned to the user. Some Oracle applications require the assignment of roles in
addition to responsibilities. Although responsibilities have the same names as roles,
they perform different functions. Responsibilities are a general feature of all Oracle
Applications and control what features of the application a user can access. By
contrast, the roles that are set up in CRM Resource Manager control what
information a user view and modify.

Note: If you have the full installation of Oracle HRMS license you
will not be able to create employees using CRM Resource Manager
and will receive an error message indicating that you must use
Oracle HRMS.

Login

Oracle Forms Applications

Responsibility

System Administrator

Prerequisites
None

Steps

1. In the Navigator window, on the Functions tab, choose Security > User >
Define.

The User window appears.

2. Inthe User Name field, enter a user name for the account. Use the following
guidelines to define Oracle Applications usernames:

= Alphanumeric characters (A’ through 'Z’, and 0" through '9’), underscore,
space, or hyphen.

s Character sets that are supported by your operating system.
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3. In the Password field, enter a password for the user account. Use the following
guidelines for creating passwords for user accounts.

s Minimum of 5 characters.
s Maximum of 100 characters.

= Alphanumeric characters (A’ through 'Z’, and 0" through ’9’), underscore,
space, or hyphen.

4. DPress Tab.

You will return to the Password field. You will need to reenter the password for
validation purposes. Once you renter the password, press Tab again.

5. In the Person field, select the employee to be associated with the username and
password.

6. In the Responsibilities tab, add the following responsibilities.
s Interaction Center Intelligence Administrator Apps
= Interaction Center Intelligence Administrator HTML
= Interaction Center Intelligence User HTML
s Interaction Center Intelligence User Apps
s Universal Work Queue Administration
»  Call Center HTML Administrator
s CRM HTML Administrator

Note: Once the user record has been saved, you cannot delete an
assigned responsibility. Oracle Applications maintains audit data
for assigned responsibilities. To deactivate an assigned
responsibility, set the effective end date in the Effective Dates - To
field for the assigned responsibility to the current date. To activate
an assigned responsibility, clear or reset the effective end date.

7. From the File menu, choose Save.

See Also
= Section 3.1, Defining an Administrator for Oracle Interaction Center Intelligence

= Section 3.2, Creating an Interaction Center Agent
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Section 3.3, Creating an Employee

Section 3.4, Creating an Employee in CRM Resource Manager
Section 3.5, Setting Up Employees as Users

Section 3.6, Importing a Resource

Oracle Applications Systems Administrator’s Guide

3.6 Importing a Resource

Use this procedure to import an employee as a resource.

Login

Oracle Forms Applications

Responsibility
CRM Resource Manager

Prerequisites

You must first set up the employee in Oracle HRMS or CRM Resource Manager.
Review CRM Foundation Concepts and Procedures.

Steps

1.

In the Navigator window, on the Functions tab, choose Maintain Resources >
Import Resources.

The Selection Criterion window appears.
In the Resource Category field, select Employee.

In the Name field, select the name of the employee you wish to import as a
resource.

If you are importing a single employee, select the employee from the list of
values. For groups of employees, search by job title, competency, or other search
criteria.

Click Search.

The employee(s) that match your search criteria will appear in the Search
Results area. The Select box for those employees that meet the search criteria
will automatically be selected.
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5. Deselect the boxes for the employees that you do not want imported as a
resource.

6. Click Create Resource.
The Default Values window appears.

7. Click OK.
The Selected Resources window appears. The Comments field indicates
whether the resource is a new record, duplicate record, or duplicate record with
a new role definition. The Select boxes are automatically selected.

8. Click Save Resource.

9. Click Details.

10. Click the Roles tab.

11. In the Roles Type field, select Call Center.

12. In the Role field, enter Call Center Agent.

13. Select the Interaction Center tab.

14. In the Interaction Center field, select the appropriate server group.

15. Enter the telephony parameters.
The parameters that you enter will depend on which telephony parameters are
required for the CTI middleware you are using.

16. Click Save.

See Also

Section 3.2, Creating an Interaction Center Agent

Section 3.3, Creating an Employee

Section 3.4, Creating an Employee in CRM Resource Manager
Section 3.5, Setting Up Employees as Users

3.7 Administering Oracle Interaction Center Intelligence

Topics include:

Section 3.7.1, Configuring Application Profile Options
Section 3.7.2, Enabling Multi-Currency Support
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= Section 3.7.3, Configuring Component Security

= Section 3.7.4, Setting Up Application Dependencies

= Section 3.7.5, Media Item Data Availability by Mode

= Section 3.7.6, Establishing Inbound Telephony Performance Goals
= Section 3.7.7, Defining Outbound Telephony Performance Goals

= Section 3.7.8, Setting eMail Center Performance Goals

= Section 3.7.9, Defining Connect and Contact Outcomes

= Section 3.7.10, Defining Positive and Negative Results

= Section 3.7.11, Running ICI Concurrent Programs

= Section 3.7.12, Running Concurrent Requests for UWQ

s Section 3.7.13, Running CCT Concurrent Programs

3.7.1 Configuring Application Profile Options

A profile option is a parameter that controls and affects the way an application
functions. The procedure for setting up and changing profile options is the same for
all Oracle Applications. The administrative user must have the responsibility of
System Administrator. For information about how to configure profile options and
a full description of each option, see Appendix A.

Note: If an Oracle Interaction Center Intelligence profile option is
not listed below, it is either intended for use by Oracle Support
Services, reserved for future use, or obsolete. Verify that the value
of an Oracle Interaction Center Intelligence profile option that is not
in use is set to No or null

The following is a list of the application profile options that apply to the
configuration of Oracle Interaction Center Intelligence:

Site Level Profile Options

= BIX: Preferred Currency
= BIX: ConversionType

= BIX: Maximum Roll Days
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= BIX: Call Center Agent Hourly Wage

= BIX: Default Chunk Size

= IEU: Session History Logging

User Level Profile Options

= BIX: Default Agent Group

s JTF_PROFILE_DEFAULT_CURRENCY
= BIX: Time Range for BIX Reports

= BIX: Reporting Calendar

See Also
s Oracle Applications Systems Administrator’s Guide

= Appendix A

3.7.2 Enabling Multi-Currency Support

ICI allows reporting in multiple currencies.

Login

Oracle Forms Application

Responsibility

Interaction Center Intelligence Administrator Apps

Note: Users need to use Interaction Center Intelligence User Apps responsibility to
update the user level profiles.

Prerequisites

Before enabling multi-currency support, the JTF_Profile_Default_Currency profile
option needs to be defined for each user.

Steps

1. Define and enable currencies you want to use.

Oracle Applications predefines all ISO currencies but the administrator can
define as many additional currencies as needed.
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2. Enter the daily rates needed for conversion.

3. In the Navigator window, on the Functions tab, choose Profiles.
The Profile window appears.

4, Search for and update the BIX: Conversion Type profile option.

This is a site level profile which is set up by the administrator to specify what
rate type should be used for currency conversion (e.g., Spot or Corporate).

5. Search for and update the BIX: Maximum Roll Days profile option.

This is a site level profile. The programs make use of this profile to convert
currency based on the following logic:

If BIX:Maximum Roll Days is a positive number, the API will look backward
from the conversion date for the most recent date for which a rate is defined
with the given currencies and conversion type. It will go backward up to the
maximum roll days specified. If it cannot find a rate, the API will raise an error.
Otherwise, it will return the rate.

If BIX:Maximum Roll Days is a negative number, the API will try to look
backward without any date limit for a rate defined with the given currencies
and conversion type. If it cannot find a rate, the API will raise an error.
Otherwise, it will return the rate.

If BIX:Maximum Roll Days is zero, the API will not try to look backward for a
conversion rate. Instead, it will raise an error.

See Also
= Appendix A

3.7.3 Configuring Component Security

Interaction Center Intelligence allows you to configure your component security.

Login
Oracle HTML Applications

Responsibility

System Administrator
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Steps
1. Click the Design tab.

2. Click the Declarative Components tab.

3. Click Component Security.

There are two available options. The Component to Responsibilities option
allows you to assign a component to multiple responsibilities. The
Responsibility to Components option allows you to assign a responsibility
access to multiple components.

4. Pick the appropriate option and then click Next.

If you select Component

to Responsibilities... Then...

1.

Select the application code (Interaction Center
Intelligence - BIX) and the component code for
which you want to assign privileges.

2. Click Next.
3. Select the responsibility application code (Interaction
Center Intelligence - BIX).
4. Select the appropriate responsibilities. Make sure your
selection appears in the Selected Responsibilities section.
5. Click Update.
If you select
Responsibility to
Components... Then...
1. Select the responsibility application code (Interaction
Center Intelligence - BIX) and the responsibility for
which you want to assign components.
2. Click Next.
3. Select the component application code (Interaction Center
Intelligence - BIX).
4. Select the appropriate components. Make sure your
selection appears in the Selected Components section.
5. Click Update.
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3.7.4 Setting Up Application Dependencies

ICI pulls in some data from other modules like Telesales and Marketing to enable
some of the cross-functional reports that it produces. However some or all of these
modules may not be installed in an organization. The summary programs will
collect data based on whether or not these modules are installed. This is meant to be
an organization-wide set up. Similarly to performance goals, these settings can be
changed at a later date. If settings are modified, the summary data which was
previously compiled will not be affected.

Login
Oracle HTML Applications

Responsibility

Interaction Center Intelligence Administrator HTML

Prerequisites
None

Steps
1. Click on the Setup tab.

2. In the side panel, click Select Application Dependencies.
3. Select the applications which are implemented.

You have the following options:

= Oracle eMail Center

»  Oracle Advanced Inbound

= Oracle Advanced Outbound

= Oracle TeleService

= Oracle TeleSales

4. Click Update.

3.7.5 Media Item Data Availability by Mode

The following table identifies the availability of media data items by mode.
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Note: If a media data item is unavailable in a particular mode, the
report when run, will not contain data for that item.

The following table lists the availability of media items by active, passive, and

enhanced mode.

Inbound Passive

(Enhanced) w/ InboundPassive
Media Item Data Inbound Active Route Point w/o Route Point
MEDIA_ITEM_TYPE TELE_INB TELE_INB TELE_DIRECT
DIRECTION Inbound Inbound Inbound
REROUTE Yes N/A N/A
MEDIA_ABANDON_FLAG Yes Yes No
SERVER_GROUP_ID Yes Yes Yes
ANI Yes Yes Yes
DNIS Yes Yes N/A
CLASSIFICATION Yes Yes Yes
START_DATE_TIME Yes Yes Yes
END_DATE_TIME Yes Yes Yes
DURATION Yes Yes Yes

The following table lists the availability of media items by direct, manual,
preview, and progressive mode.

Inbound
Media Item Data Direct Manual Dial Preview Progressive
MEDIA_ITEM_TYPE TELE_DIRECT TELE_ TBD by AO TBD by AO

MANUAL

DIRECTION Outbound Outbound Outbound Outbound
REROUTE N/A N/A N/A N/A
MEDIA_ABANDON_FLAG N/A N/A N/A N/A
SERVER_GROUP_ID Yes Yes Yes Yes
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Inbound
Media Item Data Direct Manual Dial Preview Progressive
ANI Yes Yes Yes Yes
DNIS N/A N/A Yes Yes
CLASSIFICATION Yes Yes Yes Yes
START_DATE_TIME Yes Yes Yes Yes
END_DATE_TIME Yes Yes Yes Yes
DURATION Yes Yes Yes Yes

The following table lists the availability of media items by web callback,
internal, and unsolicited mode.

Media Item Data Web Callback Internal Unsolicited
MEDIA_ITEM_TYPE TELE_WEB TELE_INTERNAL UNSOLICTED
DIRECTION Inbound N/A N/A
REROUTE Yes N/A N/A
MEDIA_ABANDON_FLAG N/A N/A N/A
SERVER_GROUP_ID Yes Yes Yes

ANI Yes Yes Yes

DNIS N/A Yes N/A
CLASSIFICATION Yes Yes Yes
START_DATE_TIME Yes Yes Yes
END_DATE_TIME Yes Yes Yes
DURATION Yes Yes Yes

3.7.6 Establishing Inbound Telephony Performance Goals

ICI allows administrators to pre-seed some key performance indicator (KPI) goals.
These goals will be used while running some of the KPI related ICI reports. This
gives the business users the ability to analyze how their agents or interaction
centers performed against the expected performance measures. This set up is
intended to be performed for the entire organization. It is recommended that careful
thought be put into the value selection for these goals. These settings can be
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changed at a later date. If settings are modified, the summary data which was
previously compiled will not be affected.

Use this procedure to indicate the performance goals for inbound telephony.

Login
Oracle HTML Applications

Responsibility

Interaction Center Intelligence Administrator HTML

Prerequisites
None

Steps
1. Click the Setup tab.

2. In the side panel, click Define Goals for Telephony.
The Define Goals for Telephony page appears.

3. Select All or a specific inbound call classification and then click Go.
The Define Goals for Telephony page refreshes.

4. In the Inbound Telephony section, enter the performance goals for the selected
classification.

The following table describes the inbound telephony performance goals.

Performance Goal Description
Service Level The percentage of calls answered within a certain time, in
seconds.

Minimum Call Threshold  The minimum call duration, in seconds, for a call to be
counted.

Inbound Abandoned Rate  The maximum percentage of abandoned calls.

5. Click Update.

See Also
»  Section 3.7.7, Defining Outbound Telephony Performance Goals
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= Section 3.7.8, Setting eMail Center Performance Goals

3.7.7 Defining Outbound Telephony Performance Goals

ICI allows administrators to pre-seed some key performance indicator (KPI) goals.
These goals will be used while running some of the KPI related ICI reports. This
gives the business users the ability to analyze how their agents or interaction
centers performed against the expected performance measures. This set up is
intended to be performed for the entire organization. It is recommended that careful
thought be put into the value selection for these goals. These settings can be
changed at a later date. If settings are modified, the summary data which was
previously compiled will not be affected.

Use this procedure to indicate the performance goals for outbound telephony.

Login
Oracle HTML Applications

Responsibility

Interaction Center Intelligence Administrator HTML

Prerequisites
None

Steps
1. Click the Setup tab.

2. In the side panel, click Define Goals for Telephony.
The Define Goals for Telephony page appears.

3. Select All or a specific inbound call classification and then click Go.
The Define Goals for Telephony page refreshes.

4. In the outbound telephony section, enter the performance goals for the selected
classification.

The following table describes the inbound telephony performance goals.
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Performance Goal Description
Outbound Abandoned The maximum percentage of abandoned calls.
Rate

5. Click Update.

See Also
= Section 3.7.6, Establishing Inbound Telephony Performance Goals

= Section 3.7.8, Setting eMail Center Performance Goals

3.7.8 Setting eMail Center Performance Goals

ICI allows administrators to pre-seed some key performance indicator (KPI) goals.
These goals will be used while running some of the KPI related ICI reports. This
gives the business users the ability to analyze how their agents or interaction
centers performed against the expected performance measures. This set up is
intended to be performed for the entire organization. It is recommended that careful
thought be put into the value selection for these goals. These may be changed at any
later date, but the summary data which is collected until that date will still be based
on the prior performance goals.

Note: If eMail Center is not being used, setup of these goals is not
required.

Use this procedure to indicate the performance goals for inbound telephony.

Login
Oracle HTML Applications

Responsibility
Interaction Center Intelligence Administrator HTML

Prerequisites
None
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Steps
1. Click the Setup tab.

2. In the side panel, click Define Goals for Email Center.
The Define Goals for Email Center page appears.
3. Select All or a specific email classification and then click Go.
The Define Goals for Email Center page refreshes.
4. In the Email section, enter the performance goals for the selected classification.

The following table describes the eMail Center performance goals.

Performance Goal Description
Service Level The percentage of e-mails answered within a certain time, in
hours.

5. Click Update.

See Also
= Section 3.7.6, Establishing Inbound Telephony Performance Goals

= Section 3.7.7, Defining Outbound Telephony Performance Goals

3.7.9 Defining Connect and Contact Outcomes

Once an interaction center is done with a call, a wrap-up of the interaction is
performed using the customer screen pop. The agent can then associate the
interaction with certain outcomes, results, and reasons. For intelligent reporting, ICI
allows interaction center administrators to map outcomes and results to connects
and positive responses. The administrator can decide if the outcome of "answering
machine" or "ring no answer" constitute a "connect". Whereas, an outcome of "busy’
constitutes a "non-connect". This mapping allows ICI to report on the percentage of
calls were "connects” or "contacts".

1

Use this procedure to indicate whether an outcome is considered a connect or
contact for the purpose of Interaction Center Intelligence bins and reports.

Login
Oracle HTML Applications
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Responsibility

Interaction Center Intelligence Administrator HTML

Prerequisites
None

Steps
1. Click the Setup tab.

2. In the side panel, click Configure Outcomes.
The Configure Outcomes page appears.
3. For each outcome, indicate whether it is a connect, contact, or neither.

4. Click Update.

See Also
= Section 3.7.10, Defining Positive and Negative Results

3.7.10 Defining Positive and Negative Results

Results can be mapped to "positive response”. This mapping allows ICI to report on
the percentages of positive responses.

Use this procedure to indicate whether a result is considered positive or negative for
the purpose of Interaction Center Intelligence bins and reports.

Login
Oracle HTML Applications

Responsibility

Interaction Center Intelligence Administrator HTML

Prerequisites
None

Steps
1. Click the Setup tab.

2. In the side panel, click Configure Results.
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The Configure Results page appears.
3. For each result, indicate whether it is a positive or negative response.

4. Click Update.

See Also
= Section 3.7.9, Defining Connect and Contact Outcomes

3.7.11 Running ICI Concurrent Programs

There are four pre-seeded concurrent programs in Oracle Interaction Center
Intelligence. They are:

= Populate Interaction Center Intelligence Calls Summary

= Populate Interaction Center Intelligence UWQ Summary

= Populate Interaction Center Intelligence eMail Summary Tasks

= Populate Interaction Center Intelligence Session Summary Tables

Use this procedure to run ICI concurrent programs.

Login

Oracle Forms Applications

Responsibility

Interaction Center Intelligence Administrator Apps

Prerequisites
None

Steps

1. In the Navigator window, on the Functions tab, choose Requests.
The Find Requests page appears.

2. C(Click Submit a New Request.
The Submit a New Request dialog box appears.

3. Select Single Request.

4. Click OK.
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The Submit Request page appears. The Submit Request page consists of three
sections:

= Run the Requests...
= At these Times...
= Upon Completion...

The Run the Requests... section allows you to select the request, enter
parameters, establish the language, and copy from a previous run.

5. In the Name field, click the ellipsis to perform a lookup.
The Report page appears.

6. Select the appropriate ICI concurrent program. The programs available for
selection are:

To Run... Select this...

ICI Calls Summary Populate Interaction Center Intelligence Calls Summary

UWQ Summary Populate Interaction Center Intelligence UWQ Summary

eMail Summary Tasks Populate Interaction Center Intelligence eMail Summary Tasks

ICI Session Summary Populate Interaction Center Intelligence Session Summary

Tables Tables

7. Click OK.

The Parameters dialog box appears.

8. In the Start Date field, enter a date to indicate the beginning of the date range
for the request to be run. You must use the the following format:
DD-MMM-YYYY H:MM:S.

9. The current date will display as the default in the End Date field. If you need to
adjust the date, enter the desired end date using the same format as required for
the start date.

10. Click OK.

11. In the At these Times... section, select Schedule. You can specify when the

request will run. Click OK when finished.
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To Schedule... Select this...

ASAP As Soon As Possible
One time only Once

Periodic runs Periodically

Select days On Specific Days
Other Advanced

12. In the Upon Completion... section, click Options to specify the output
conditions for the request. You can specify who to notify upon completion as
well as print output (print to file or device) and language. Click OK when
finished.

13. Click Submit.

This will run the concurrent program. It is recommended that as the
administrator, you monitor the log files after each run to ensure the requests
completed successfully.

= Section 3.7.12, Running Concurrent Requests for UWQ

ms  Section 3.7.13, Running CCT Concurrent Programs

3.7.12 Running Concurrent Requests for UNQ

Oracle Universal Work Queue uses a concurrent program to clean up inactive
sessions and activities which might be left in an "active" state, for example, system
failure or power failure. ICI administrators should work with the UWQ
administrators to ensure that the program, Session History - UWQ Cleanup Process
is set up to run periodically.

Use this procedure to verify the set up and run UWQ concurrent programs.

Login

Oracle Forms Applications

Responsibility

Universal Work Queue Administration Responsibility
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Prerequisites

None

Steps

1. In the Navigator window, on the Functions tab, choose Concurrent Requests >
Run.
The Submit a New Request dialog box appears.

2. C(Click Single Request.

3. Click OK.
The Submit Request page appears. The Submit Request page consists of three
sections:
= Run the Requests...
s At these Times...
= Upon Completion...
The Run the Requests... section allows you to select the request, enter
parameters, establish the language, and copy from a previous run.

4. In the Name field, click the ellipsis and perform a lookup.
The Report page appears.

5. Select Sessions History-UWQ Cleanup Process.

6. Click OK.

7. Click OK.

8. Inthe At these Times... section, select Schedule. You can specify when the
request will run. Click OK when finished.

To Schedule... Select this...

ASAP As Soon As Possible

One time only Once

Periodic runs Periodically

Select days On Specific Days

Other Advanced
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9. In the Upon Completion... section, click Options to specify the output
conditions for the request. You can specify who to notify upon completion as
well as print output (print to file or device) and language. Click OK when
finished.

10. Click Submit.

This will run the concurrent program. It is recommended that as the
administrator, you monitor the log files after each run to ensure the requests
completed successfully.

See Also
m  Section 3.7.11, Running ICI Concurrent Programs

ms  Section 3.7.13, Running CCT Concurrent Programs

3.7.13 Running CCT Concurrent Programs

In Oracle Call Center and Telephony, interaction history data is not populated
real-time. Before any ICI reports are executed, as the administrator, you will have to
run the following CCT concurrent programs. After the first run, the programs will
automatically be scheduled. The administrator is responsible for making sure that
the programs are restarted in the event of database failure or other exception
conditions. The programs that need to be run are:

s Close Media Items
s Timeout Media Items

The default value for close media items is 15 minutes. The default value for timeout
media items is 24 hours. The system administrator can modify these parameters if
necessary, when the jobs are submitted.

Use this procedure to verify the set up and run CCT concurrent programs.

Login

Oracle Forms Applications

Responsibility

Interaction Center Intelligence Admin Apps

Prerequisites
None
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Prerequisites
None

Steps

1.

In the Navigator window, on the Functions tab, choose Requests.

The Find Requests page appears.

2. C(Click Submit a New Request.
The Submit a New Request dialog box appears.
3. Select Single Request.
4. Click OK.
The Submit Request page appears. The Submit Request page consists of three
sections:
= Run the Requests...
= At these Times...
= Upon Completion...
The Run the Requests... section allows you to select the request, enter
parameters, establish the language, and copy from a previous run.
5. Inthe Name field, click the ellipsis to perform a lookup.
The Report page appears.
6. Select the appropriate CCT concurrent program. The programs available for
selection are:
To run.... Select this...
Close Media Items
Timeout Media Items
7. Click OK.
The Parameters dialog box appears.
8. Identify the appropriate parameter for the request.
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If the Program is... Select this...

Close Media Item Interval to close media items in minutes. The default is 15
minutes.

Timeout Media Items Timeout interval in hours. The default is 24 hours.

9. C(lick OK.

10. In the At these Times... section, select Schedule. You can specify when the
request will run. Click OK when finished.

To Schedule... Select this...

ASAP As Soon As Possible
One time only Once

Periodic runs Periodically

Select days On Specific Days
Other Advanced

11. In the Upon Completion... section, click Options to specify the output
conditions for the request. You can specify who to notify upon completion as
well as print output (print to file or device) and language. Click OK when
finished.

12. Click Submit.

This will run the concurrent program. It is recommended that as the
administrator, you monitor the log files after each run to ensure the requests
completed successfully.

See Also
= Section 3.7.11, Running ICI Concurrent Programs

= Section 3.7.12, Running Concurrent Requests for UWQ
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Diagnostics and Troubleshooting

This section contains instructions on error corrections and workarounds for
problems that you may encounter in the implementation of Oracle Interaction
Center Intelligence.

Topics include:
m  Section 4.1, "Functional FAQs"
s Section 4.2, "Technical FAQs"

4.1 Functional FAQs

Was Interaction Center Intelligence (ICl) renamed recently?

Yes, Interaction Center Intelligence was renamed from Call Center Intelligence in
11iR5 to align itself with the Interaction Center product family.

Who is the primary audience for ICI?

ICI is an operational call center reporting solution focusing on telephony data. Call
center supervisors and managers are the primary users of ICI; however, agents can
also use ICI for self monitoring and motivation.

Does ICI go after real time data?

Yes, real time reports query directly from the transactional systems. But ICI
historical reports employ an architecture where OLTP data is collected into
summary tables, so a set of concurrent requests need to be executed before running
reports.

Diagnostics and Troubleshooting 4-1



Functional FAQs

How current are historical reports? Are time series supported?

Historical data may be collected in time buckets as small as half an hour. If you set
up ICI collection programs to run every half hour, your historical reports will at
most be half an hour behind.

When would you implement ICI?

ICI is the only operational reporting solution for OTM in active mode; similar to a
switch reporting solution for a switch. Typically the transactional business
application e.g., TeleService or TeleSales, is implemented; followed closely by Al or
AQ; after which ICI is implemented

Why are two OTM passive modes supported?

In OTM active mode, OTM is performing the routing. In OTM passive mode, the
ACD is performing the routing. OTM has two passive modes based on the
middleware: CT-Connect passive and Cisco-ICM passive. Route point monitoring is
supported by CT-Connect and NOT supported by Cisco-ICM.

What measures and reports are available if OTM is passive?

In CT-Connect passive mode, there is no visibility to route and queue times as the
ACD is performing this task. Therefore, measures like ASA, Average Caller
Transaction Time, Calls Handled by Primary Destination are not available.

In Cisco-ICM passive mode, route point monitoring is not supported and there is no
visibility till the call is with the agent. Therefore, additional measures like Longest
Call Waiting, Calls Offered, Calls Abandoned, Average Abandon Time, Calls within
Service Level, Average Wait to Abandon, Service Level are not available.

What are ICl's transactional dependencies?

ICI is pre-integrated with Oracle TeleService, Oracle TeleSales and Oracle Universal
Work Queue.

What are your TeleService dependencies?

ICI derives its Service Request information from TeleService. Specifically, service
requests created, open and closed. ICI looks into Interaction History to find agents
and interaction times to match service requests created, opened or closed.

What are your TeleSales dependencies?

ICI derives its Leads and Opportunity information from TeleSales. Specifically,
leads created, updated, lead amounts and opportunities created, updated, won,
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won opportunity amounts. ICI looks into Interaction History to find agents and
interaction times to match leads and opportunities created, updated or won.

What are your Universal Work Queue dependencies?

ICI derives its login and logout times, and the break reasons from Universal Work
Queue.

What type of data security is supported?

As in all Oracle e-Business applications, responsibilities limit the choice of functions
available to a user. In addition, ICI supports data security dictated by a user's
position in the agent group hierarchy. ICI supports managers and members.

Managers of agent groups have access to any agent group or agent under them.
Members of agent groups have access only to their own data.

Are there any Oracle Discoverer workbooks in this release?
At present, there are no workbooks in ICL.

Does ICI provide multi-site support?
Yes, ICI supports multiple call center sites setup on the same database instance.

Does ICI provide multi-currency support?
Yes, ICI supports daily rate multiple currencies.

4.2 Technical FAQs

Some bins and reports do not bring up any data.

Check the base transaction tables to see if data should be brought up in the reports.
Try running some simple queries against the transaction tables using the same
query criteria and parameters as the bin and report in question. If this brings up
data, but the bin and report does not then perform the other checks mentioned
below:

= Does the summary table have data?
= Were there any errors in running the concurrent programs?

= Have you set yourself up with a default group, as explained in the Setup
section?
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Graph is not displayed

Check if the post-install steps for the Oracle CRM Foundation product (JTF)
were performed correctly.

Make sure the Apache web server is configured to use the correct display
server.

Make sure the display server up and running.

Make sure you are using JDK 1.2.2 or a higher version.

If all the setup steps look okay;, try restarting the Apache web server.

Some bins/reports give “invalid permission error"

Log on to the CRM Foundation HTML (JTF) page as the administrator and grant the
components to the appropriate responsibilities.

Unable to log on to Oracle Applications (Forms)

Make sure the Forms server is up and running.
Make sure the database is up and running.
Make sure you are using the correct version of JInitiator.

If JInitiator gives a "Out of Memory" error, try clearing the contents of the jcache
directory (typically located under C:\Program Files\Oracle\]JInitiator\jcache).

Try restarting the Forms Server.

Unable to log on to Oracle Applications (HTML/JTF login)

Make sure the Apache web server is up and running.

If any new patches were applied recently, make sure you clear out the Java
cache and restart the Apache web server.

Try restarting the Apache web server.
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Oracle Interaction Center Intelligence

Profile Options

This appendix provides a listing of the system profile options used by Oracle
Interaction Center Intelligence.

Topics include:

Appendix A.1, "Profile Values"

Appendix A.2, "Setting System Profile Options"
Appendix A.3, "Application Profile Options"
Appendix A.4, "User Profile Options"

A.1 Profile Values

When an Oracle Applications user performs a login or changes responsibility,
Oracle Applications establishes a value for each option in a user’s profile.

The profile option description includes the following information:

Required: Indicates whether the profile option must be set.

Personal Profile Values: Indicates whether a user can view or update the
profile option. Oracle Applications users with the Preferences responsibility
may use the Personal Profile Values window to set their own personal profile
options at the user level. Not all profile options are visible to users and some
profile options, while visible, may not be updated by users.

System Profile Values: Indicates the levels at which a particular profile option
can be set. System administrators can set profile options at the site, application,
responsibility, and user levels. Not all profile options have settings at all levels.
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= Settings: Lists available values, a description of each value, and any usage
considerations.

s Default Value: Indicates the default profile option value if no value has been
set. Depending on the how the profile option is used in the application, the
default may be a predefined value or it may be determined dynamically at
runtime.

A.2 Setting System Profile Options

The procedure for setting up and changing system profile options is the same for all
Oracle Applications.

Use this procedure to set or change profile options.

Login

Oracle Forms Applications

Responsibility

System Administrator

Prerequisites
»  Review Oracle Applications Systems Administrator’s Guide.

Steps

1. In the Navigator window, on the Functions tab, choose Profile > System.
The Find System Profile Values window appears.

2. Check the level(s) for which you want to set the profile option. The available
levels are as follows:

= Site
= Application

This level allows you to choose the application for which you will set the
profile option. Select the application from the list.

= Responsibility

This level allows you to choose the responsibility for which you will set the
profile option. Select the application from the list.
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s User

This level allows you to select the user for which you will set the profile
option. Select the application from the list.

In the Profile field, enter the profile name (e.g., BIX: Maximum Roll Days), or
perform a lookup by entering the application prefix along with the percent
symbol. For example, to locate all Oracle Interaction Center Intelligence
profiles, you would enter "BIX%".

Click Find.
The profiles are displayed in the System Profile Values window.
Select a value from the list.

A profile option may be set at more than one level. When this is performed, the
value entered at the Site level has the lowest priority. The value entered at the
Site level is superseded by any value entered at the Application level value and
the value entered at the Application level is superseded by an value entered at
the Responsibility level. The value entered at the User level has the highest
priority and overrides values entered at any other level.

Verify or set the profile option(s) at the levels that you selected.
Click Save.

A.3 Application Profile Options

Topics include:

Appendix A.3.1, "BIX: Preferred Currency"

Appendix A.3.2, "BIX: Conversion Type"

Appendix A.3.3, "BIX: Maximum Roll Days"

Appendix A.3.4, "BIX: Call Center Agent Hourly Wage"
Appendix A.3.5, "BIX: Delete Chunk Size"

Appendix A.3.6, "IEU: Queue: Session History Logging"

See Also

Oracle Interaction Center Intelligence User Guide

Oracle Applications Systems Administrator’s Guide
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= Appendix A.1, "Profile Values"
= Appendix A.2, "Setting System Profile Options"

A.3.1 BIX: Preferred Currency

This is the main currency that the customer conducts business in. This is also
referred to "Consolidated Currency". This is a site level profile.

Note: Users need to use the Interaction Center Intelligence User
Apps responsibility to update the user level profiles.

Use this profile option to identify the currency the main currency with which
business is conducted.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

A.3.2 BIX: Conversion Type

ICI allows for reporting in multiple currencies. This profile option is used to specify
what rate type should be used for currency conversion, for example, Spot or
Corporate. This is a site level profile.
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Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

A.3.3 BIX: Maximum Roll Days

This profile option is used to determine the basis for which currency is converted.
ICI performs the conversion based on the following logic:

If BIX:-Maximum Roll Days is assigned a positive number, the API will look
backward from the conversion date for the most recent date for which a rate is
defined with the given currencies and conversion type. It will go backward up
to the maximum roll days specified. If it cannot identify a rate, the API will
generate an error. Otherwise, it will return the rate.

If BIX:-Maximum Roll Days is assigned a negative number, the API will try to
look backward without any date limit for a rate defined with the given
currencies and conversion type. If it cannot identify a rate, the API will generate
an error. Otherwise, it will return the rate.

If BIX:-Maximum Roll Days is zero, the API will not try to look backward for a
conversion rate. Instead, it will generate an error.

Note: Users need to use the Interaction Center Intelligence User
Apps responsibility to update the user level profiles.

This is a site level profile.
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Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

A.3.4 BIX: Call Center Agent Hourly Wage

This profile is used by the summary program to calculate the cost of calls. The Key
Comparison by Period report uses hourly wage for calculating costs. This is a site
level profile.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
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User? Yes

A.3.5 BIX: Delete Chunk Size

The concurrent programs use this profile to decide on the number of records that
need to be inserted into the summary tables, before a database commit is
performed. The administrator needs to decide on an optimum number for this
profile depending on the rollback segment space. The higher this number, the better
it is for performance, but too high a number could result in the rollback segments
running out of space. If this profile is not set, then a default of 100 is used by the
summary programs. This is a site level profile.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

A.3.6 IEU: Queue: Session History Logging

This is a site level profile which is used by the UWQ OLTP application, but it affects
the functioning of ICI as well. This profile needs to be set to Yes to capture UWQ
session information into IEU tables, which are used by ICI.

When set to No, session related data will not be written to the IEU tables.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

A.4 User Profile Options
Topics include:
= Appendix A.4.1, "BIX: Default Agent Group"
s Appendix A.4.2, "JTF_Profile_Default Currency"
= Appendix A.4.3, "BIX: Time Range for BIX Reports"
= Appendix A.4.4, "BIX: Time Reporting Calendar"

A.4.1 BIX: Default Agent Group

Each user will be associated with a default group. If the user is not set up with a
default group, some of the bins and reports may not show any data. This will have
to be done individually by each user as this is a user level profile.

Some of the bins and reports restrict data based on the user’s default group. These
components show data only for (1) all agents in the user’s default group; and (2) all
immediate child groups of the user’s default group. In a future release, this
behavior will be enhanced and extended to all bins and reports.

Note: Users must be assigned the Interaction Center Intelligence
User Apps responsibility. They will need to log in, using this
responsibility, to update user level profile options.
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Use this profile option to associate a user with a default group.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? No
Application? No
Responsibility? No
User? No

A.4.2 JTF_Profile_Default_Currency

The default currency in which the reports will display the currency columns. This is
the profile that users should change if they want to change the currency in which
their reports are displayed.

Note: Users must be assigned the Interaction Center Intelligence
User Apps responsibility. They will need to log in, using this
responsibility, to update user level profile options.

Use this profile option to set the default currency that will display.

Required
No

Personal Profile Values

View? Yes

Oracle Interaction Center Intelligence Profile Options A-9



User Profile Options

Update? Yes

System Profile Values

Site? No
Application? No
Responsibility? No
User? No

A.4.3 BIX: Time Range for BIX Reports

Some of the call related reports show data broken down to a certain period (half
hour, 1 hour etc.). This profile will help the user customize the reports based on
what time range they want to see the data broken down by. This is a user level
profile.

Note: Users must be assigned the Interaction Center Intelligence
User Apps responsibility. They will need to log in, using this
responsibility, to update user level profile options.

Use this profile option to specify the interval of time for which the data on the
reports represents.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? No
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Application? No
Responsibility? No
User? No

A.4.4 BIX: Time Reporting Calendar

The BIX: Reporting Calendar profile option is used to determine the type of
calendar to be used for reporting. For example, reporting can be done based on the
Gregorian calendar or the company’s fiscal calendar.

Use this profile option to establish the reporting calendar that will be used for
reporting.

Note: Users must be assigned the Interaction Center Intelligence
User Apps responsibility. They will need to log in, using this
responsibility, to update user level profile options.

Use this profile option to specify the interval of time for which the data on the
reports represents.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? No
Application? No
Responsibility? No
User? No
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